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Abstract

KGeography is a geography learning tool for KDE. Right now it has six usage
modes:

Browse the maps clicking in a map division to see its name, capital and flag

The game tells you a map division name and you have to click on it

The game tells you a capital and you have to guess the division it belongs to
e The game tells you a division and you have to guess its capital

e The game shows you a map division flag and you have to guess its name

The game tells you a map division name and you have to guess its flag
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Chapter 1

Introduction

KGeography is a geography learning tool for KDE. It allows you to learn about
the political divisions of some countries (divisions, capitals of those divisions
and their associated flags if there are some).

Maps available in current release are: Africa, Asia, Austria, Brazil, Canada,
China, Europe, France, Germany, Italy, Italy by provinces, North and Central
America, Norway, Poland, South America, Spain, USA and the world.
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Chapter 2

Quick Start to KGeography

When you run KGeography for the first time, it first asks you to choose a map
to start with.

Choose map to use - KGeography

Asia
Austria
Brazil
Canada
China
Europe
France
Germany

ltaly @
[taly by provinces

Here we choose Canada
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Choose map to use - KGeography

Africa
Asia
Austria
Brazil

China
Europe
France
GFermany

Italy @
[taly by provinces

[ (]34 H zancel l

And KGeography main window appears with the map of Canada:

KGeography
File Wiew Settings Help

Current map
Canatla

Browse the map

Click division in the map

Guess the capital of a division

Guess division frorm its Nag

|
|
Guess division from s capital I
|
|
|

Guess the flag of a division

You can then choose what type of learning or testing you want to do by looking
at the menu on the left:
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Current map:
Canada

zlick divizion in the map

Fess division from its capital

Eess the capital of a division

Guess division fram its flag

EUuess the flag of a division

Browse the map: a left mouse button click on an area of the map will display

informations about that area:
=

Click division in the map: you are first asked how many questions you want
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= Number of questions - KGeograpt 2 —

Howy many questions do you want? 1 to 13

Then you are asked to click on a specific province:

izarrect answers: 000
Flease click on Munawut

When you finish all the questions, a result dialog is shown with your correct
and uncorrect answers:
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YOur answers were - KGeography

Click on ...
Cuestion Your answer Correct answer

Munawut I
Mewfoundland

Mew Brunswick I
Prince Edward Island || NN
Yukon Territary I e
Ontarig I
Marth West Territories [N

Mova Scotia I

Gluehec

Saskatchewan I

You answered correctly B out of 10 gquestions

Guess a division from its capital: you are asked to find the name of a province
among a choice of 4 given its capital:
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Yellowknife is the capital of..

() Maova Scotia

() Marth West Territaries
) Mewfoundland

() Yukon Tertitory

Accept

And the results are displayed when the test is finished:
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Your answers were - KGeography

... Is the capital of ...

Question Your answer Correct answer
Yellowknife  Mewfoundland Morth West Territories
Victaria British Calumbia British Calumbia
Stdohn's Mewfoundland Mewfoundland
Fegina Saskatchewan Saskatchewan

Charlottetown Prince Edward Island  Prince Edward [sland

Halifax Mova Scotia Mova Scotia
Toronta Ontario Ontario
Winnipeng hanitoha hanitoha
Fredericton  Mew Brunswick Mew Brunswick

Whiteharse  Morh West Territaries Yukon Territory
You answered correctly 8 out of 10 guestions

Guess the capital from a division: you have a capital and four province names
and you must choose the correct one. As before, at the end a result dialog is
shown.

Guess division from its flag: a flag is shown and you must find the province it
belongs to.
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This flag helongs to:

() Quebec
() Prince Edward Island
() Maorth West Territories
() Munavut

Accept

Guess the flag of a division: a province name is given and you must find the
correct flag among four.
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The flag of Mew Brunswick is...

o R

S

I:::I 1= B=

GBF
P

@Eﬂ_zﬂ

Accept
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Chapter 3
Using KGeography

KGeography displays informations about some countries and tests you about
those informations.

] KGeography - 0 X
File  \iew Seftings Help

(SNENE

Current rrap:
Canada

Browse the map

Click division in the map

Guess the capital of a division

Guess division from its Nlag

|
J
Guess division from jts capital ]
]
J
|

Guesg the flag of a division

(il

3.1 More KGeography features

Another feature of KGeography is the possibility of zoom on a map.
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KGeography
Eile View Settings Help

B 4

Current map:
Canada

Browse the map

Click division in the map

Guess division from jts capital

Guess the capital of a division

Guess division from its flag

Guess the flag of a division

]

&

E10]

While in zoom mode, you can press right mouse button to go back to the orig-
inal map size (the Original Size action has the same effect). Use the scroll bars
to move around the zoomed map or use the Move action that will allow you to

drag the map using left mouse button.
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Chapter 4

How to make maps

A map in KGeography is made by two files, one is the image of the map and
the other one is its description.

4.1 Helper tool

You can find here a tool (made by Yann Verley) which helped him with the map
of France. To find out its usage, simply execute it and read the help message.
It basically creates the .kgn file from a plain text file and creates a file with the
colors it has assigned to each division, so you can fill the map according to
them.

4.2 Description file

The description file is needed and its file extension is .kgm. It should begin
with <map> and end with </map>.

Inside of those tags there should be:

e <mapFile> and </mapFile>: the name of the file (without any path) con-
taining the map image, e.g. ‘europe.png’.

e <name> and </name>: the name of map, e.g. ‘Europe’.

e A <division> and </division> for each division in the map.
Each division has these tags:

e <name> and </name>: the name of the division, e.g. “Albania’.

13
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e <capital> and </capital>: the name of the capital of the division, e.g.
‘Tirana’.

e <ignore> and </ignore>: can be set to yes, allowClickMode and no. If this
tag is set to yes then the division will be ignored when asking for divisions
in that map. It is then as if this division does not exist in KGeography quiz
modes. If this tag is set to allowClickMode then KGeography will ask for the
division in the Click Division in Map... mode but not in other quiz modes.
Setting this tag to no means the division will appear in all modes (browse
and quizzes). This tag is optional and when there is no <ignore> tag that
means as it is set to no. For example “Algeria’ has this tag set to yes in the
‘Europe’ map which means that ‘Algeria” will not be part of any quiz in the
‘Europe’ map.

e <flag> and </flag>: the file (without any path) containing the flag of the
division, e.g. ‘albania.png’. This tag is optional. Not needed for the divisions
whose <ignore> tag is set to yes.

e <color>and </color>: the color the division has in the map.
The color is defined using three tags:

e <red>and </red>: red component of the color. Valid values are between 0
and 255.

e <green> and </green>: green component of the color. Valid values are
between 0 and 255.

e <blue> and </blue>: blue component of the color. Valid values are be-
tween 0 and 255.

TiP
It is convenient to create 2 or 3 false divisions like ‘Water’, ‘Frontier’ and ‘Coast’ and
set them with the <ignore> tag set to yes.

IMPORTANT
All names (capitals and divisions) must be in English.

4.3 Map file

The map file is quite simple but laborious to create. It has to be in PNG format.
You can find some maps to transform at Cia Reference Maps. If no map fits
your needs you can download the political world map, take a screenshot of
it and work from it. Each division in the map should have one and only one
color. To achieve this you can use image processing programs like The Gimp
and Kolourpaint.

14


https://www.cia.gov/cia/publications/factbook/docs/refmaps.html
https://www.cia.gov/cia/publications/factbook/reference_maps/pdf/political_world.pdf

The KGeography Handbook

4.4 Flags

If you have used the <flag> tag you should provide the flag files. They have
to be in PNG format and better if they are 300x200 pixels and you provide a
SVG file for it. To obtain SVG flags of almost all countries in the world and
some other divisions, you can consult the Sodipodi flags collection.

4.5 How to test

Before sending your map to Albert tsdgeos@terra.es, you should test it to see

it has no errors. To achieve that, you have to do the following:

e Put the map description and map image file in $KDEDIR/share/apps/kgeography/
e Put the flag PNG files (if any) in $KDEDIR/share/apps/kgeography/flags/

Once that has been done you should be able of opening your map from inside
KGeography.

If you don’t know which is your $KDEDIR, type kde—config --prefix in a
shell.

4.6 Non political maps

Is it possible to do non-political maps? Yes, it is!

Of course, the division concept can be extended to a river or a mountain. Dur-
ing the creation of the map, you should keep in mind that most times the river
or mountain will be too small that you should provide an additional click-
ing area. In this example the river would have the maroon area and color
<20,76,34> as its identifier.

15
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Chapter 5

Command Reference

5.1 The main KGeography window
5.1.1 The File Menu

File — Open Map... (Ctrl+O) Open the choose map dialog
File — Quit (Ctrl+Q) Quits KGeography

5.1.2 The View Menu

View — Zoom Goes in zoom mode

View — Original Size Sets the map back to its original size

View — Move Moves the current map

5.1.3 The Settings Menu

Settings — Show/Hide Toolbar Show/Hide the KGeography toolbar.
Settings — Configure Shortcuts... Configure key shortcuts for KGeography.
Settings — Configure Toolbars... Configure the KGeography toolbar.
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5.1.4 The Help Menu

Help — KGeography Handbook (F1) Invokes the KDE Help system starting
at the KGeography help pages. (this document).

Help — What's This? (Shift+F1) Changes the mouse cursor to a combination
arrow and question mark. Clicking on items within KGeography will
open a help window (if one exists for the particular item) explaining the
item’s function.

Help — Report Bug... Opens the Bug report dialog where you can report a
bug or request a ‘wishlist’ feature.

Help — About KGeography This will display version and author informa-
tion.

Help — About KDE This displays the KDE version and other basic informa-
tion.

17



The KGeography Handbook

Chapter 6
Credits and License

KGeography
Program copyright 2004-2005 Albert Astals Cid tsdgeos@terra.es
Documentation Copyright (c) 2005 Anne-Marie Mahfouf annma@kde.org

This documentation is licensed under the terms of the GNU Free Documenta-
tion License.

This program is licensed under the terms of the GNU General Public License.
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Appendix A

Installation

A.1 How to obtain KGeography
KGeography is part of the KDE project http:/ /www.kde.org/ .

KGeography can be found in the playground/edu package on ftp:/ /ftp.kde.org/-
pub/kde/ , the main FTP site of the KDE project.

A.2 Compilation and Installation

In order to compile and install KGeography on your system, type the following
in the base directory of the KGeography distribution:

$ ./configure
% make
% make install

Since KGeography uses autoconf and automake you should have no trouble
compiling it. Should you run into problems please report them to the KDE
mailing lists.
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